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CHAPTER OBJECTIVES

After completing this chapter you should:

1. understand how to use the
Customize User Interface window;

2. know how to create and edit a
command;

3. be able to use special characters in
a command macro;

4. understand the different user inter-
face elements;

5. understand partial and enterprise
customization files;

6. be able to transfer customization
from a previous release.

CUSTOMIZING
THE USER
INTERFACE
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CONCEPTS
This chapter builds on the introduction of the Customize User Interface window that was covered in
Chapter 44.  Here, you will learn how different components of the user interface can be managed and
customized using the Customize User Interface window (CUI).  In previous releases, customizing the user
interface was not something that could be accomplished entirely from within AutoCAD using the
Customize dialog box.  Instead, the Customize dialog box was limited to customizing toolbars, toolbar
buttons, tool palettes, and keyboard shortcuts.

In previous releases of AutoCAD, if you wanted to customize pull-down menus, shortcut menus, screen
menus, or digitizing tablet menus or create non-standard shortcut keys, it had to be done externally to
AutoCAD using a text editor.  Customizing these menus externally required a fair amount of time and
expertise and was reserved for experienced AutoCAD users.

AutoCAD 2006 introduces a much easier and intuitive way to customize the user interface completely
from within AutoCAD.  This new approach uses the Customize User Interface window for customizing
most aspects of accessing commands, including toolbars, pull-down menus, shortcut (right-click) menus,
keyboard shortcuts, and mouse buttons, as well as legacy interface elements such as screen menus,
image tile menus, and digitizing tablet menus.  The CUI tool is used to create and save a new feature
called workspaces, which is helpful for managing the display of specific user interface elements.

CUSTOMIZATION FILE TYPES AND LOADING CUSTOMIZATION

Customization File Types

Customization for AutoCAD is made up of a set of files that work together to define the appearance and
functionality of the user interface that is loaded with each session of AutoCAD.  A number of file exten-
sions are associated with the basic AutoCAD customization file.  The following table defines the various
file extensions that may be associated with the customization file:

File Extension Description
.CUI Customization file: This XML-based file contains the definitions of commands

and user interface elements, such as toolbars and pull-down menus.
.MNR Menu resource file: This binary file contains the bitmaps used by the cus-

tomization file.
.MNL Menu LISP file: This ASCII file contains AutoLISP expressions that are used

by the customization file.  It is loaded into memory when a customization file
of the same name is loaded.

NOTE:  Before you begin to create your own customization, you should make a backup copy of the
ACAD.CUI and the ACAD.MNL files.  Then you can safely make alterations to the new files for your
own customization needs and restore the original files if needed.  Each new customization file you create
should have its own .MNL file (using the same filename) to evaluate and load the necessary LISP rou-
tines to interact with the other menu files.
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Loading Menu Files

The Menu command loads a Customized User
Interface (CUI) file or a Legacy Menu Template File
(.MNU/.MNS).  Normally this command is used to
load a base, or core, customization file, complete with
all user interface elements such as pull-down menus,
toolbars, shortcut menus, image tile menus, screen
menus, etc.  The Menu command opens the Select
Customization File dialog box (Fig. 45-1) to enter or
select a customization file name.  

When the FILEDIA system variable is set to 0, the command line issues the following prompt:

Enter customization file name or [. (for none)] 
<C:\Documents and Settings\...\support\acad>:

The name of the most recently loaded customization file is stored in the system registry.  The name of
this customization file can be accessed with the system variable MENUNAME.  The last customization
file used is loaded each time you restart AutoCAD.  In order to speed up initial drawing loads,
AutoCAD does not reload the customization file each time you open a drawing file in any one AutoCAD
session.  The main customization file can be specified under the Customization Files node of the Files tab
in the Options dialog box.

Each time you restart AutoCAD or load a specific customization file with the Menu command, AutoCAD
systematically searches for the menu file based on the library search path (see “Library Search Path”).

Menu Command Alias Short- Screen (side) Tablet
Pull-down Menu (Type) (Type) cut Menu Menu

… Menu … … … …

FIGURE 45-1

Cuiload Command Alias Short- Screen (side) Tablet
Pull-down Menu (Type) (Type) cut Menu Menu

… Cuiload … … … …
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The Cuiload command is used to load additional customization files that contain a subset of the user
interface elements that are in a base customization file.  These files are known as  partial customization
files.  Partial customization files support all the same user interface elements that the base files do, with
the exception of workspaces.  If a partial customization file is loaded that contains pull-down menus, the
pull-down menus are not automatically loaded in the menu bar of AutoCAD.  To load the additional
pull-down menus, they must be added to a workspace.  

The Cuiload command produces the
Load/Unload Customizations dialog
box (Fig. 45-2).  Use the Menu Groups
of the dialog box to Load, Unload and
Browse for partial customization files.
When the FILEDIA system variable is
set to 0, the command line issues the
following prompt:

Enter name of customization file 
to load:

The Cuiunload command also produces the Load/Unload Customizations dialog box (see Fig. 45-2).  Here
you can unload and load partial customization files.  When the FILEDIA system variable is set to 0, the
command line issues the following prompt:

Enter the name of a Customization Group to unload:

FIGURE 45-2

Cuiunload Command Alias Short- Screen (side) Tablet
Pull-down Menu (Type) (Type) cut Menu Menu

… Cuiunload … … … …
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Library Search Path

When AutoCAD attempts to locate a customization file specified by the system registry, the
MENUNAME system variable, or the Menu or Cuiload commands, the following search path order is
used:

1. Current directory
2. Directory that contains the current drawing file
3. Directories listed in the Support path (for more information, see “Support File Search Path” in the

Installation Guide)
4. Directory that contains the AutoCAD program files

NOTE:  Two or more of these directories may be the same, depending on your drawing environment.

Loading Order for Customization Files

When AutoCAD initially starts, or when a drawing is either created or opened, several things take place
from the standpoint of customization files.  Below is the order in which the menu customization files are
loaded.

Files loaded at the initial startup of AutoCAD:

1. ACAD2006.LSP
2. ACAD.LSP
3. ACAD2006DOC.LSP
4. ACADDOC.LSP
5. ACAD.MNL

Files loaded when opening an existing drawing or creating a new drawing:

1. ACAD2006.LSP
2. ACAD2006DOC.LSP
3. ACADDOC.LSP
4. ACAD.MNL

ACAD2006.LSP and ACAD2006DOC.LSP are located by default in the Support directory.  By default,
AutoCAD is installed in C:\Program Files\AutoCAD 200X (where X represents the number of the current
release).

ACAD.LSP and ACADDOC.LSP are user-created files that do not exist by default and are used to over-
ride or configure AutoCAD settings and create new commands with the AutoLISP programming lan-
guage.

ACAD.MNL is the .MNL file that is associated with the ACAD.CUI file.  Each customization file can
have its own .MNL file for loading external AutoLISP, VBA project or ObjectARX files that contain com-
mands that the customization might be dependent on.  The .MNL file is loaded last and can be used to
override any setting or command created in any of the previously loaded LSP files up to that point. 

When the ACADLSPASDOC system variable is set to 1, the file ACAD.LSP is loaded when opening or
creating a new drawing. 
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UNDERSTANDING THE CUSTOMIZE USER INTERFACE WINDOW
Use the Cui command to produce the Customize User Interface window.

The Cui command produces the Customize User Interface window (Fig. 45-3).  As an alternative to the
options shown in the table above, you can produce the Customize User Interface window by selecting the
Window pull-down menu, then Workspaces, Customize.  

The Customize User Interface window provides an easy and visual method to accomplish all aspects of
customization for the user interface.  With this tool, even novice AutoCAD users can get involved with
customization without the required tedium and expertise required in previous releases of AutoCAD.  

Cui Command Alias Short- Screen (side) Tablet
Pull-down Menu (Type) (Type) cut Menu Menu

Tools
Customize
Interface... Cui     … … … …

FIGURE 45-3
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In the top-left section (see Fig. 45-3), note the existence of two different tabs:  Customize and Transfer.  The
Customize tab allows you to create and manage the different user interface elements and is the primary
subject of this chapter.  The Transfer tab allows for migrating customization to and from other customiza-
tion files.  (If you have an existing menu customization file from a previous release, you use this tab to
get the customization into the AutoCAD 2006 CUI file format.  The Transfer tab is discussed later in this
chapter.)

Customizations in Pane

Located just below the tabs of the Customize User
Interface window is the Customizations in pane (Fig. 
45-4).   This pane helps you to accomplish many tasks,
such as controlling which elements are displayed in
the tree, creating new user interface elements, orga-
nizing elements, and loading partial customization
files. 

Drop-down list
The drop-down list displays the customization files
that are currently loaded and an option to Open a cus-
tomization file.  By default there are two options that
are listed along the top of the drop-down list.  The
first option is called All Customization Files, which dis-
plays the main and enterprise customization files
along with any partial customization files in the tree
view of the Customizations in pane.  The second option
is called Main CUI File (Acad.cui), which is used to
only display the contents that are associated with the Main Customization File that is called out under
the Customization Files node of the Files tab in the Options dialog box.  Other customization files might
appear in the drop-down list, which are related to the Enterprise CUI File or partial customization files.

Load partial customization file 
The Load partial customization file button (just to the right of the drop-down list) opens the Open
dialog box and allows you to browse for a customization file or a legacy menu file.  The selected
file is then loaded into the Customize User Interface window and added under the Partial CUI Files
node of the current main customization file.

Save all current customization files
The Save all current customization files button commits all changes of the loaded .CUI files out to
disk.

Open Display Filter Dialog
The Display Filter Dialog button produces the dialog box shown in Figure 45-5.  This dialog box
allows you to control which user interface elements are displayed or hidden in the tree view.
This action affects only the Customizations in pane and has no effect over what is displayed in the
user interface of AutoCAD.

FIGURE 45-4
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Tree View
The Tree View is the heart of the Customizations in pane and is the loca-
tion used to associate a command with a user interface element.  This
area displays the selected customization file from the drop-down list
and the user interface elements based on the options selected in the
Display Filter dialog box (Fig. 45-5).

Command List Pane

Located just below the Customizations in pane is the
Command List pane (Fig. 45-6).  This pane allows for
managing the inventory of standard and custom com-
mands that are part of the loaded customization files.

Categories Drop-down list
The Categories drop-down list provides a filtering mecha-
nism for the commands that are in the list box below.  The
Categories drop-down list includes four main categories,
All Commands, ACAD Commands, Custom Commands and
Control Elements.  Along with these four main categories
there are many other categories that match the standard
pull-down menu names except for one called Legacy.  The
Legacy category contains the commands that are related to
the Legacy user interface elements like Screen Menus and
Tablet Menus. 

New
The New button creates a new command, where
Command1 is the default command name.  Each new command that is created has its default name incre-
mented by one if a command with that name already exists as part of the customization file.  When the
New button is selected, two dynamic panes are displayed along the right side of the Customize User
Interface window.  These two panes are named Button Image and Properties (see “Dynamic Display Pane”).

Command list box
The Command list box displays all the commands that are part of the selected category and in the loaded
customization files.

FIGURE 45-6

FIGURE 45-5
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Dynamic Display Pane

Located on the right side of the Customize User
Interface window is the Dynamic Display pane (Fig.
45-7).  This part of the window is not just one pane,
but rather a collection of different panes that are dis-
played based on what is currently selected in the
Customizations in or Command List panes.  Some of
the panes that are found in this area are Button
Image, Properties, and Workspace Contents.

Information pane
The Information pane (not shown) provides a
description for select user interface elements that do
not have properties.  This information gives a brief
overview of the user interface element and a related
link to the online AutoCAD Help file.  The top level
nodes in the tree view such as the Menus and
Toolbars nodes display an Information pane. 

Properties pane
The Properties pane (see Fig. 45-7) displays the properties of user interface elements from the tree view of
the Customizations in pane and commands from the Command List pane.  User interface elements that
display properties are pull-down menus, shortcut menus, toolbars, toolbar buttons, shortcut keys,
among many others.

Button Image pane
The Button Image pane (see Fig. 45-7) displays controls to specify a pre-created image to a command from
the Command List pane or access to the Button Editor dialog box where you can create custom images for a
command.

Shortcuts pane
The Shortcuts pane (not shown) displays the Shortcut Keys and Temporary Keys that have been defined in
the customization file.

Workspace Contents pane
The Workspace Contents pane (not shown) is used to organize how Toolbars, Pull-down Menus and Dockable
Windows are to be organized on screen.

Preview pane
The Preview pane (see Fig. 45-19) is used to give feedback on how a Toolbar will look after it is cus-
tomized.  The Preview pane is activated when a Toolbar is selected in the tree view, not a Toolbar Button.

FIGURE 45-7
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Properties Pane
Located on the right side of the Customize User
Interface window is the Properties pane (Fig.
45-8).  This pane is part of the Dynamic
Display pane, which allows for tweaking stan-
dard and custom commands, and user inter-
face elements that are part of the loaded cus-
tomization files.

Sort properties according to categories
The Sort properties according to categories button allows for controlling how the properties are
organized within the Properties grid.  If selected, a hierarchy is used to display and logically orga-
nize the properties of the selected command or user interface element.  This is the default view
for the Properties grid.

Sort properties alphabetically
This button allows for controlling how the properties are organized within the Properties grid.
This format is based on the name of the property and does not use a hierarchical format.

Toggle the display of the Tips box below the Properties grid
Use this button to toggle the display of the tips box at the bottom of the Properties pane.  This box
gives a quick and simple description of the selected property in the grid.  The tips box is dis-
played by default.

Reset Defaults
The Reset Defaults button allows for restoring any changes to the properties of a command or user inter-
face element before the changes have been committed to the .CUI file.  Changes in the Properties pane are
displayed in bold text.

Button Image Pane

Located on the right side or upper-right corner of
the Customize User Interface window is the Button
Image pane (Fig. 45-9).  This pane is part of the
Dynamic Display pane which allows assigning,
selecting and creating custom images for both stan-
dard and custom commands that are part of the
loaded customization files.

FIGURE 45-9

FIGURE 45-8
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Specify Image Size
The three option buttons on the left side of the pane allow for assigning a Small, Large and/or Both image
sizes to a command when selecting an image from the Image List.  Select one of the image size options
before assigning an image to a command to have it assign the image to the small and/or large image
fields simultaneously.

Image Preview
Image Preview displays the image that is currently assigned to a command or is the image that has been
selected from the list box, and will be displayed in the Button Editor dialog box if the Edit button is
clicked.

Edit
Edit displays the Button Editor dialog box,
(Fig. 45-10), which is used to create custom
images for commands.  The images are
added to the Image List box of the Button
Image pane and saved out to file on disk
with the file extension .BMP.

Image list box
Image List box contains the images that are
part of the loaded customization files.  The
images are loaded from the compiled .MNR
files.

CREATING A COMMAND
When you create new user interface elements such as toolbars or pull-down menus, it helps to organize
and improve the work flow based on company standards.  A “command” is used to organize a group of
properties that are used to form the foundation of the many user interface elements in a customization
file.  On the next page is an overview of the properties that are part of a command.

Properties of a Command

The following properties are listed in the Properties pane when a command is highlighted in the
Customizations in list or the Command List pane.

Name
The command Name is used in several ways for user interface elements and the .CUI file.  The name is
used to locate the command in the Command List pane, the caption for a menu item, and the tool tip for a
toolbar button.

FIGURE 45-10
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Description
When the cursor is hovering over the menu item or toolbar button that the command is associated with,
the Description is displayed in the status bar and provides information about the command.

Macro
A Macro is used to define the specific task that will be carried out when the command is executed from
the user interface element that it has been assigned to.  A macro must be defined with the proper syntax,
otherwise you may get unexpected results.  Every character in a macro is significant—even blank spaces
serve a vital purpose and must be located properly.  With each revision and upgrade of AutoCAD,
command syntax might change, so you may be required to make minor changes to your customization.
Sometimes with new releases, command names or options can change.

One example of a command name change is the Hatch command, which in previous releases was the
Command line version of the Bhatch command.  In AutoCAD 2006, Bhatch was renamed Hatch, which
opens the Hatch and Gradient dialog box.  Therefore, to invoke the Command line version of the Hatch
command, it must be prefixed with a dash (-).  See “Special Characters for Macros” for more information
on the significance of the dash and other characters in macros.

To specify a macro, enter the value in the text field.  If the macro is lengthy, click the ellipsis button
located at the right side of the text field.  This action opens the Long String Editor (Fig. 45-11).  In previous
releases you used a plus sign when dealing with long macro strings, which is no longer the case in
AutoCAD 2006.

Element ID
The Element ID is used to create a unique identifier for
the command or user interface element and is enforced by
the Customize User Interface window.  This value is used
when importing customization from other .CUI files and
even among the current .CUI file when a command is
assigned to a user interface element.  To specify an Element
ID, enter the value in the text field.

Small Image
The Small image designates which icon will be displayed next to a menu item or on a toolbar button.  The
image must measure 16x16 pixels in size, otherwise it will be scaled to fit.  There are two different ways
to assign a small image to a command.  The first is to select either the Small or Both option buttons in the
Button Image pane, then select an image from the list on the right side of the Button Image pane.  The
second method is to select the Small image field in the Properties pane.  Selecting the Small image field dis-
plays an ellipsis button that allows you to browse for a custom image with the file extension .BMP, .RLE
or .DIB.  These are the only types of image files that can be used for a custom image of a command.

FIGURE 45-11
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Large Image
A Large image is used only on a toolbar button when the option Use large buttons for Toolbars is checked
under the Display tab of the Options command.  The image must measure 32x32 pixels in size, otherwise
it will be scaled to fit.  There are two different ways to assign a large image to a command.  The first is to
select either the Large or Both option buttons in the Button Image pane, then select an image from the list
on the right side of the Button Image pane.  The second method is to select the Large Image field in the
Properties pane.  Selecting the Large image field displays an ellipsis button that allows you to browse for a
custom image with the file extension .BMP, .RLE or .DIB.  

Creating a Command

To create a new command follow these steps:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Command List pane, click the New button.  Both the Button Image and Properties panes open in

the Dynamic Display pane.
3. Make the necessary changes to the new command.  You should change at least the Name, Macro,

Description and Element ID.
4. Click Apply to save the new command to the .CUI file.

Editing a Command

To edit a command follow the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. Select the command that you are interested in editing from the Command List pane.  If needed, use

the Categories drop-down list to help locate the command.
3. Select the command in the list box.  This action opens both the Button Image and Properties panes for

the selected command.
4. Make the necessary changes to the command’s properties.
5. Click Apply to save the custom command to the .CUI file.

Removing a Custom Command

To remove a custom command, follow the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. Select the command that you want to remove from the Command List pane.  Use the Categories drop-

down to locate the command if needed.
3. Select the command in the list box and right-click.  From the right-click menu, select Delete.
4. Click Apply to save the changes back to the .CUI file.

NOTE:  Since you cannot undo this deletion after applying the changes to the .CUI file, make sure you
won’t need the command in the future.  As an alternative to deleting a command, it may be better to
remove the command from the user interface elements.
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UNDERSTANDING A MACRO
Creating macros can be somewhat intimidating and confusing at first.  However, with some experience
you will find that creating macros is not much more advanced that using commands and their options at
the command line.  The following table is from the AutoCAD 2006 Customization Guide and explains
many of the special characters that are used with macros.

Special Characters for Macros

Character Description
; (Semicolon) Issues Enter 
^M Issues Enter
^I Issues Tab
[blank space] Enters a space; a blank space between command sequences in a command is

equivalent to pressing the Space bar
. (Period) Use the default AutoCAD command definition if it was redefined 
\ (Backslash) Pauses for user input 
_ (Underscore) Translates AutoCAD commands and keywords that follow 
=* Displays the current top level pull-down, shortcut, or image menu
* (Asterisk) Repeats a command until another command is chosen or the Escape

key is pressed 
$ ($M=) Special character code that loads a menu section or introduces a condi-

tional DIESEL macro expression 
^B Toggles Snap on or off (Ctrl+B)
^C Issues a single Escape (ESC)
^D Toggles Coords on or off (Ctrl+D)
^E Sets the next isometric plane (Ctrl+E)
^G Toggles Grid on or off (Ctrl+G)
^H Issues a backspace
^O Toggles Ortho on or off (Ctrl+O)
^P Toggles MENUECHO on or off
^Q Echoes all prompts, status listings, and input to printer (Ctrl+Q)
^T Toggles Tablet on or off (Ctrl+T)
^V Changes the current Viewport (Ctrl+V)
^Z Null character that suppresses the automatic addition of the Space bar at the

end of a command

Examining a Macro

Seeing all the special characters in a single table is helpful, but it doesn’t give a full understanding how
they might be used together to form a macro.  The following macro is what is used for the command
Circle, Diameter from the Command List pane.

^C^C_circle \_d

Each of the elements of this macro is explained below.

^C^C = A single ^C acts like pressing the ESC key.  Two are commonly added to a
macro to ensure that the current command is cancelled.  The Color option of the
Layer command requires up to three presses of the ESC key to exit the
command and any option.
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_ (underscore) = This element translates the following command or option into a foreign lan-
guage release of AutoCAD.  The use of the underscore character is optional,
but recommended if you work for a company that might have international
offices.

circle = Uses the AutoCAD Circle command.
[blank space] = Issues an Enter to start the Circle command.
\ = Pauses for user input, in this case it is the center point of the circle object.  Each

backslash that is part of the macro is a request for user input.
_d = Use the Diameter option of the AutoCAD Circle command.
blank = AutoCAD automatically adds a blank space at the end of the macro to ensure

the command or option prior to it is executed.

Examine the prompts at the command line for the Circle command and how they match up with the
macro.

Command: circle
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: (Select a point or enter a coordinate
value)
Specify radius of circle or [Diameter]: d
Specify diameter of circle: (Enter a diameter size, select a point or enter a coordinate value)

NOTE:  Since the backslash (\) pauses for user input, whenever you need to specify a directory path you
need to use two backslashes together (\\) or a single forward slash (/) for any and all directory path
delimiters (for example, “\\directory\\filename”  or “/directory/filename”).

When you use the backslash to pause for user input, continuation of the macro will be delayed under the
following conditions:

1. When input of a point is expected, the user may set Object Snap modes prior to entering the data to
the prompt for a point.

2. When X/Y/Z point filters are used, the macro is suspended until the entire point is entered.
3. For the Select command only, the menu item does not resume until object selection is completed.
4. When the user responds with a transparent command, the menu macro remains suspended until the

transparent command is completed and the original requested input is received.
5. When the user responds by choosing another menu item to supply options, the menu macro remains

suspended until the options portion is processed and the original requested data is received.
6. When the user responds by selecting a completely different command, most likely the menu macro

will be terminated.

It is often difficult to read blank spaces within a macro (and especially at the end of a macro), so in these
cases you could use the semicolon ( ; ) character.  Below is the same macro that was previously shown for
the Circle, Diameter command with the exception of using semicolons instead of blank spaces to represent
the pressing of the Enter key.  The macro works exactly the same.

^C^C_circle;\_d;
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WORKING WITH TOOLBARS
One of the most important elements of the user interface is a toolbar.  The ability to customize toolbars
can greatly improve your overall productivity.  As you have seen in Chapter 44, it is fairly straightfor-
ward to add new commands to an existing toolbar.

Properties of a Toolbar

When a toolbar is selected in the Customizations in pane, the Preview pane and the Properties pane appear
on the right side of the Customize User Interface window.  The following items appear in the Properties
pane.

Name
The Name section can be used to locate the toolbar in the Customizations in pane and serves as the caption
of the toolbar when it is floating (undocked).

Description
If you rest the pointer in an open area of the toolbar, the Description of a toolbar is displayed in the Status
bar at the bottom of the AutoCAD window.  You can place a description of the toolbar, pull-down menu,
or shortcut menu in the field, or you might also place information such as the last date of the revision
history here.

On By Default
This setting is used to control the initial state of the toolbar when the customization file is loaded the first
time.  After the initial loading of the toolbar, the display is controlled by the current AutoCAD profile or
workspace.  To specify the display state, select the field and click the arrow on the drop-down.  There are
only two choices in the drop-down, either Hide (Off) or Show (On).  By default when a new toolbar is
created, the default for the display of the toolbar is set to Show.

Orientation
Orientation is used to control whether the toolbar is initially docked or floating.  After the initial loading
of the toolbar, the orientation is controlled by the current AutoCAD profile or workspace.  To specify the
orientation, select the field and click the arrow on the drop-down.  There are five choices in the drop-
down list, Floating, Top, Bottom, Left and Right.  When a new toolbar is created, the default orientation is
set to Floating.

Default X Location
The Default X Location determines the initial location of the toolbar from the left side of the screen when it
is floating (undocked).  The upper-left corner of the screen is 0,0 (the origin) and where all measurements
are made from.  To specify a new X location, enter a positive value into the field.  The higher the number,
the farther right the toolbar will be placed on screen.  If a negative number is entered, the toolbar will not
appear on the screen.

Default Y Location
The Default Y Location determines the initial location of the toolbar from the top side of the screen when it
is floating (undocked).  To specify a new Y location, enter a positive value into the field.  The higher the
number, the farther down the toolbar will be placed on the screen.  If a negative number is entered, the
toolbar will not appear on the screen.

Rows
The value in Rows specifies how many rows of buttons the toolbar will have when it is floating
(undocked).  To specify the number of rows, enter a number in the field.
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Aliases
Aliases are used to display and access a toolbar
through one of the programming languages that
can be run inside AutoCAD and are used when
creating a Flyout (see “Adding a Flyout”).  To
specify a new alias or to change an existing one,
select the field to display the ellipsis button.  Click
the ellipsis button to display the Aliases dialog box
(Fig. 45-12).  Enter one alias per line by placing the
cursor at the end of the last line and pressing Enter
to create a new line.  Press OK to add the list of
aliases for the toolbar.  It is a good idea to change
the default alias to prevent future problems when
migrating customization files.

Element ID
The Element ID is a unique identifier for the toolbar
and is enforced by the Customize User Interface
window.  This value is used when importing cus-
tomization from other .CUI files and when a
command is assigned to a user interface element in the current .CUI file.  To specify an Element ID (for
new commands only), enter the value in the text field.

Creating a Toolbar

To create a new toolbar follow the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, right-click on the Toolbars node in the tree view.  Select New> Toolbar

from the shortcut menu.  The Properties pane opens in the Dynamic Display pane.
3. Make the necessary changes to the new toolbar’s properties.  As a minimum, you should change the

Name and Aliases properties.
4. In the Command List pane, locate the command(s) that you want

to add to the new toolbar.  Select the command with the left
mouse button.  Hold down the left mouse button while you drag
and drop the command up to the new toolbar under the Toolbars
node (Fig. 45-13).

5. Click Apply to save the new toolbar to the .CUI file.

NOTE:  More than one command can be selected at a time by using the Ctrl and Shift keys when select-
ing commands in the Command List pane.  This action allows you to quickly add a number of commands
to a user interface element, such as a toolbar or pull-down menu.

Editing a Toolbar

To edit a toolbar follow the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, click the plus sign next to the Toolbars node in the tree view. 
3. Select the toolbar that you want to change.  The Properties pane opens in the Dynamic Display pane.
4. Make the necessary changes to the toolbar properties and its associated commands.
5. Click Apply to save the changes back to the .CUI file.

FIGURE 45-12

FIGURE 45-13



A Separator is used to organize items into groups of com-
mands that are used to perform related tasks.  AutoCAD
uses separators on many of the standard toolbars.  As an
example, consider how separators are used on the
Dimension toolbar to organize the different types of tools
(Fig. 45-14).  A Separator in the Customize User Interface
window is represented by the Name “- -” and has the prop-
erty Is separator which is set to Yes and cannot be changed
(Fig. 45-15).

To add a Separator to a toolbar, follow the steps below:

1. Use the CUI or Toolbar command to open the Customize
User Interface window.

2. In the Customizations in pane, click the plus sign next to
the Toolbars node in the tree view.

3. Select the toolbar that you are interested in adding a
Separator to.

4. Right-click the command above the location you want
the Separator to be inserted.

5. Click Apply to save the changes back to the .CUI file.

Adding a Flyout

A Flyout is used to display a toolbar that “flies out” from
another toolbar.  There are many existing standard
flyouts  in AutoCAD, such as the group of block-related
commands from the Draw toolbar.  These commands are
added to the toolbar based on the contents of the Insert
toolbar.  Figure 45-16 shows the Block flyout on the Draw
toolbar.  A flyout on a toolbar is represented by a small
black triangle in the lower right corner of the button.  In
the Customize User Interface window, a flyout is represented
by a toolbar node with its commands located below it (Fig.
45-17).
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FIGURE 45-14

FIGURE 45-15

FIGURE 45-16

FIGURE 45-17

Adding a Separator
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To add a Flyout to a toolbar follow these steps:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. Create a new toolbar following the steps outlined previously (see “Creating a Toolbar”).
3. In the Customizations in pane, locate the toolbar you want to use as a flyout.  Select the toolbar with

the left mouse button and hold down the left mouse button.  Drag the selected (flyout) toolbar to and
drop it under the desired (parent) toolbar.  A copy of the original toolbar is not created for the flyout,
but instead an association to the original toolbar and all of its commands is created.  

4. Click Apply to save the changes back to the .CUI file.

NOTE:  It is possible to create a new flyout by right-clicking over the toolbar and selecting New> Flyout
from the shortcut menu.  This action creates a new toolbar and automatically adds the flyout association
to the toolbar.  Next, add the commands to the new toolbar.

Properties of a Flyout

A Flyout shares many of the same properties that a command has, with two exceptions.  Below are the
properties that are unique to a flyout.

Source Toolbar
Source Toolbar is the first alias under the Aliases property of the referencing toolbar that is being used as
the flyout.  This property is automatically assigned, and there is no way of changing the Source Toolbar
unless it is deleted and re-added to the toolbar.

Use Own Icon
The Use Own Icon property specifies whether the flyout displays a different icon than the image of the
most recently used command.  By default this value is set to No, but if it is set to Yes the images assigned
to the properties Small image and Large image are used.

Organizing Commands, Separators and Flyouts on a Toolbar

Organizing commands, separators, and
flyouts after they have been added to the
toolbar is crucial to making them easy to find
and use.  The same process that is used to
add commands to a toolbar or to create a
flyout should be used to organize the buttons
on a toolbar.  Select the command, separator,
or flyout and drag it up or down under the
toolbar.  A drop location indicator (Fig. 45-18)
is displayed to show where the item will be
located when it is dropped.  Once you have
organized the items under the toolbar, it is
possible to preview the toolbar by selecting
the toolbar under the Toolbars node.  This
action displays the Preview pane (Fig. 45-19).

FIGURE 45-18

FIGURE 45-19
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WORKING WITH PULL-DOWN MENUS
The second most commonly used user interface element (after toolbars) is pull-down menus.  Pull-down
menus are not quite as immediately accessible as toolbars, but they normally contain more commands
than the standard toolbars.  In addition, pull-down menus, compared to toolbars, conserve valuable
space within the drawing area.  Pull-down menus fall in the range of aliases POP1 through POP499.
Only the first 16 menus are displayed automatically when the customization file is loaded into
AutoCAD.  If more than 16 pull-down menus are to be displayed you need to control the display of the
pull-down menus within a workspace.

Properties of a Pull-down Menu

Pull-down menus are listed under the Menus section of the Customizations in pane in the Customize User
Interface window.  When a pull-down menu is selected from the list, the Properties pane appears on the
right side displaying the following items.

Name
The Name edit box serves as the caption of the pull-down menu as it appears in the menu bar along the
top of the application window of AutoCAD. 

The Name property can contain an ampersand (&), which displays an underscore under the character
immediately following the ampersand in the caption.  The underscored character serves as the key that is
used to access the pull-down menu from the keyboard with the combination of the Alt key.  For example,
the Name of the File pull-down menu in the Customize User Interface window is “&File”, which allows you
to press and hold the Alt key followed by the F key to open and navigate the menu from the keyboard.
See “Special Characters for Pull-down and Shortcut Menus” for information on how to add conditionals
to a menu item, such as making a disabled menu item.

Description
The Description or pull-down menu is used for informational purposes but is not displayed on the Status
bar.

Aliases
Aliases are used for displaying and accessing a pull-down menu through one of the programming lan-
guages that can be run in AutoCAD.  To specify a new alias or to change an existing one, select the field
to display the ellipsis button, then click the ellipsis button to display the Aliases dialog box.  Enter one
alias per line.  Press Enter to create a new line.  Click OK to complete the process.  Remember to change
the default alias to prevent problems migrating customization files.

Element ID
Element ID is used to create a unique identifier for the pull-down menu and is enforced by the Customize
User Interface window.   This value is used when importing customization from other .CUI files or when
a command is assigned to a user interface element in the current .CUI file.  Enter a value in the text field
to specify an Element ID.

Creating a Pull-down Menu

Follow these steps to create a new pull-down menu:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, right-click over the Menus node in the tree view.  Select New> Menu

from the shortcut menu.  The Properties pane opens on the right side.
3. Make the necessary changes to the new pull-down menu’s properties.  At minimum, you should

change the Name and Aliases properties.
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4. In the Command List pane, locate the command(s) that you want to add to the new pull-down.  Drag
and drop the command up to the new pull-down menu under the Menus node.  

5. Click Apply to save the new pull-down menu to the .CUI file.

NOTE:  When selecting commands in the Command List pane, you can select multiple commands using
the Ctrl or Shift keys.  This action allows you to quickly add a number of commands to a user interface
element, such as a toolbar or pull-down menu.

Editing a Pull-down Menu

To edit a pull-down menu follow the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, click the plus sign next to the Menus node in the tree view. 
3. Select the pull-down menu that you want to change.  The Properties pane opens on the right side of

the window.
4. Make the necessary changes to the pull-down menu properties and its associated commands.
5. Click Apply to save the changes to the pull-down menu back to the .CUI file.

Adding a Separator

You can use a Separator to organize menu items into groups of commands that are used to perform
related tasks.  A separator in the Customize User Interface window is represented with the Name “- -” and
has a disabled property, Is separator. 

Follow the steps below to add a separator to a toolbar:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, click the plus sign next to the Menus node in the tree view. 
3. Select the desired pull-down menu.
4. Right-click the command above the location where you want to insert the separator, then select Insert

Separator from the menu.
5. Click Apply to save the changes back to the .CUI file.

Adding a Sub-menu

A Sub-menu, or cascading menu, is very
similar to a flyout on a toolbar, but it is
created differently.  A flyout represents the
contents of another toolbar, whereas a sub-
menu is similar to a directory folder that con-
tains commands within it; however, these
commands are not linked to the parent menu
item.  Sub-menus often contain options of a
command.  There are many instances of stan-
dard sub-menus in AutoCAD, such as the
Draw pull-down menu that utilizes several
different sub-menus to access options of one
main command.  Items are added to a sub-
menu the same way commands are added to a
toolbar.  Figure 45-20 shows the Arc sub-menu
under the Draw pull-down menu.  

FIGURE 45-20



22 Chapter 45

Copyright 2006 The McGraw-Hill Companies.  All rights reserved.

A small black arrow on the right side of the menu item in a pull-
down menu indicates the availability of a sub-menu.  In the
Customize User Interface window, a sub-menu is shown in hierar-
chical format (Fig. 45-21).

To add a sub-menu to a pull-down menu follow these steps:

1. Use the CUI or Toolbar command to open the Customize User
Interface window.

2. In the Customizations in pane, click the plus sign next to the
Menus node in the tree view. 

3. Select the desired pull-down menu.
4. Right-click on the desired command in the main menu and

select New> Sub-menu from the options.  Add any commands
to the new sub-menu as desired.

5. Click Apply to save the changes back to the .CUI file.

Special Characters for Pull-down and Shortcut Menus

Character Description
$( Enables the pull-down or shortcut menu item label to evaluate a DIESEL

string macro if $( are the first characters.
~ Label prefix that makes a menu item unavailable.
!. Label prefix that marks a menu item with a check mark. 
& An ampersand placed directly before a character specifies that character as the

menu accelerator key in a pull-down or shortcut menu label.  For example,
“S&ample” displays in the menu as “Sample.”

\t Specifies that all label text to the right of these characters is pushed to the
right side of the menu item label.  \t is interpreted as a tab character.

&& Displays an ampersand character in the menu items label.

Organizing Commands, Separators, and Sub-menus on a Pull-down Menu

Organizing the new commands, separators, and sub-menus is important for making them easy to find and
use.  The same process that is used to add commands to a pull-down menu or sub-menu is used to orga-
nize the menu items on a pull-down menu.  That is, select the command, separator, or sub-menu and
drag it up or down under the pull-down menu.  A drop location indicator is displayed to designate the
position for the item.  Unlike a toolbar, there is no way to preview a pull-down menu until it has been
saved and added to the menu bar of AutoCAD.

WORKING WITH SHORTCUT MENUS
Shortcut menus are very similar to pull-down menus except they are event-driven and context sensitive.
In other words, the shortcut menu that is displayed and the options that appear on it are dependent on
several conditions current at the time you invoke the menu.  The shortcut menu can depend on the
pointer location, whether an object is selected, or if a command is in progress.  The possible areas in the
AutoCAD window that can cause a specific shortcut menu to appear are listed on the next page.

FIGURE 45-21
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Drawing area
Command line
Dialog boxes and windows such as DesignCenter
Toolbars
Status bar
Model tab and layout tabs

Shortcut menus are defined in a very similar fashion to pull-down menus except they use a special
naming convention for aliases.  This naming convention determines when the shortcut menu is used.
Shortcut menus fall in the range of aliases POP0 and POP500 through POP999.  The first shortcut menu,
POP0, defines the default Object Snap shortcut menu, and POP500 through POP999 are reserved for
context shortcut menus.

Properties of a Shortcut Menu

Produce the Properties pane on the right side of the Customize User Interface window by selecting a menu
name under the Shortcut Menus section of the Customizations in pane.  When a shortcut menu is selected
from the list, the Properties pane displays the following items.

Name
The Name is the shortcut menu item that appears (generally the command name) but can contain special
characters.

Description
Description is the text that is displayed in the status bar area.  

Aliases
An Alias can be used to display and access a shortcut menu using one of the programming languages
that can be run in AutoCAD.  The alias determines when the shortcut menu should be displayed (see
“Context Menu Types”).  To specify a new alias or to change an existing one, select the field to display
the ellipsis button.  Click the ellipsis button to display the Aliases dialog box.  Enter one alias per line.
Select OK to add the new aliases.

Element ID
The Element ID field is used to create a unique identifier for the shortcut menu.   This value is used when
importing customization from other .CUI files and in the current .CUI file when a command is assigned
to a user interface element.  

Using Shortcut Menus in the Drawing Area

When your pointing device is located in the drawing area and you right-click, one of six shortcut menus
appears: the Default menu, Edit-mode menu, Command-mode menu, Object Snap menu, Hot Grips
menu, or the OLE menu (see “Shortcut Menus” in Chapter 1).  The following table describes how to
access the shortcut menus that are displayed when you right-click in the drawing area.

Shortcut menu How to access Menu options
Default Right-click when no commands are active and no objects are selected, and

select Copy, Paste, Pan, or Zoom.
Edit Cancel the active command, select the desired objects, and right-click. Options

are specific to the kind of object selected.
Command While a command is active, right-click.  Options are specific to the command

in progress and any options currently displayed on the command line.
Object Snap Press Shift and right-click.  Select from object snap options, object snap set-

tings, and point filters.
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Hot Grips Select a grip on an object, then right-click.  Grip editing options are available.
OLE Right-click an OLE object and select from the OLE object editing options.

You can control the action of the Default menu, Edit-mode menu, and Command-mode menus using the
User Preferences tab in the Options dialog box (explained next in “Controlling Default-mode, Edit-mode,
and Command-mode Shortcut Menus”).  For information about additional shortcut menus, see “Using
Other Shortcut Menus.”

Controlling the Default-mode, Edit-mode, and Command-mode Shortcut Menus

The Object Snap, Hot Grips, and OLE shortcut menus are always turned on.  However, you can control
the display of the Default-mode, Edit-mode, and Command-mode shortcut menus using the Options
dialog box.  Changes you make in the dialog box to control the display of these menus are automatically
stored in the SHORTCUTMENU system variable.  Alternately, you can make changes directly to the
SHORTCUTMENU system variable instead of using the Options dialog box.

To turn off the display of the Default-mode, Edit-
mode, and Command-mode shortcut menus in
the drawing area, open the Options dialog box.  In
the upper-left corner of the User Preferences tab
(Fig. 45-22), remove the check from Shortcut menus
in drawing area.

If you want to control the Default-mode, Edit-
mode, and Command-mode menus individually,
select the Right-click Customization button in the
User Preferences tab (see Fig. 45-22).  This action
opens the Right-Click Customization dialog box (Fig.
45-23).  A brief explanation of the options is given
here.

FIGURE 45-22

FIGURE 45-23
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Default Mode and Edit Mode

Repeat Last Command
Selecting this option turns off the Default-mode and Edit-mode shortcut menus.  Right-clicking has the
same effect as pressing the Enter key; that is, right-clicking repeats the last command.

Shortcut Menu
This option turns on the Default-mode or Edit-mode shortcut menu when you right-click in the drawing
area.

Command Mode

Enter
This option turns off the Command-mode shortcut menu.  Right-clicking in the drawing area while a
command is in progress has the same result as pressing the Enter key.

Shortcut Menu: always enabled
When this option is checked, right-clicking in the drawing area while a command is in progress always
displays the Command-mode shortcut menu.

Shortcut Menu: enabled when command options are present
This option displays the Command-mode shortcut menu only when options are currently available in
the command line prompt.  Command line options are shown in enclosed square brackets [like this].  If
no options are available, right-clicking has the same effect as pressing Enter.

SHORTCUTMENU

The SHORTCUTMENU system variable stores right-click customization settings that you specify in the
Options dialog box as described in the previous section.  You can, however, specify the right-click cus-
tomization settings directly using the SHORTCUTMENU variable.  See AutoCAD 2006 Instructor
Appendix A, for the legal bit code settings you can use.  Keep in mind that understanding the purpose of
the SHORTCUTMENU system variable is essential to your ability to write customized menus in
AutoCAD.

In addition to specifying your preferences for the Default-mode, Edit-mode, and Command-mode short-
cut menus using the Options dialog box and the SHORTCUTMENU system variable, you can customize
the individual options that are displayed on them by using the Customize User Interface window.  For
example, you may want to add options to the Edit shortcut menu that appear only when a certain type
of object is selected.  For information about writing customized shortcut menus, see “Working with Pull-
Down Menus.”

Using Shortcut Menus Outside the Drawing Area

In addition to right-clicking in the drawing area to display shortcut menus, you can right-click in other
AutoCAD window areas to display shortcut menus.  The following table describes ways to access these
shortcut menus and the options that appear.  These shortcut menus cannot be turned off by using the
Options dialog box or the SHORTCUTMENU system variable.  In other words, settings in the SHORT-
CUTMENU system variable do not affect these menus.
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Shortcut menu How to access Menu options
Toolbar Right-click on any toolbar.  Hide, display, or Customize (right-click the empty

area to the right of the Standard toolbar to display a list of toolbar menu
groups).

Command Line Right-click the command line or the text window.  Options are Recent com-
mands, Paste to Cmd line, Copy, Copy History, Paste, and Options.

Dialog Box or Right-click individual items in most dialog boxes or windows.  Depending on
Window the type of dialog box or list, the options are: Rename, Delete, Copy, Paste, and

other file management commands and context-specific options.
Status Bar Right-click the coordinate display or any Status bar buttons.  Select from On,

Off, and Settings.
Model/Layout Right-click the Model tab or any of the layout tabs.  Select New layout, From tem-

plate, Delete, Rename, Move or Copy, Select all layouts, Page Setup, Plot, or Publish
Selected Layouts.

Context Menu Types

The names GRIPS, CMDEFAULT, CMEDIT and CMCOMMAND are reserved shortcut menu aliases for
use by AutoCAD.  It is possible to extend these shortcut menus to add your own commands to them or
create new shortcut menus when editing or running a command that doesn’t have a menu defined by
default. 

GRIPS
The content of this menu defines the Hot Grip shortcut menu (right-click in the drawing area while an
object’s grip is hot [selected]).

CMDEFAULT
The content of this menu defines the Default-mode shortcut menu (right-click in the drawing area while
no command is active and no objects are selected).

CMEDIT
The content of this menu defines the Edit-mode shortcut menu (right-click in the drawing area while one
or more objects are selected [but no grips are hot], and no command is active).  In addition to the content
of the CMEDIT menu, the appropriate object menu (if one exists) is inserted into this menu when one or
more of a specific object type is selected.  Object menus use the following naming convention:

OBJECT(S)_objectname

If a single object is selected, the OBJECT_objectname menu is used, and if more than one of the same
object is selected, the OBJECTS_objectname is used.  If no OBJECT_objectname is available, AutoCAD
uses the OBJECTS_objectname menu (if one exists).

The object name is the DXF name of the object in all cases except the insert object.  To differentiate
between a block insertion and an xref, use the names BLOCKREF and XREF.  The following AutoLISP
code defines the command OTYPE, which reports the selected object’s DXF name.

(defun C:OTYPE() (cdr (assoc 0 (entget (car (entsel))))))

CMCOMMAND
The content of this menu defines the Command-mode menu (right-click in the drawing area while a
command is active).  In addition to the content of the CMCOMMAND menu, the command line options
(keywords within the square brackets) are inserted into this menu.
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Like the CMEDIT menu, the CMCOMMAND menu can have context-sensitive information added to it.
Any menu named COMMAND_commandname is appended to the CMCOMMAND menu.  The text of
commandname can be any valid AutoCAD command, including any custom-defined or third-party
commands.  To make this work with a hyphen-prefixed command (such as -Insert), you need to name the
menu COMMAND_-insert.

Creating a Shortcut Menu

To create a new shortcut menu follow the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, right-click on the Shortcut Menus node in the tree view.  Select New>

Shortcut Menu from the menu that appears.  The Properties pane opens on the right.
3. Make the necessary changes to the new shortcut menu’s properties.  At minimum you should change

the Name and Aliases properties.  In order for the shortcut menu to work properly when editing one
or more objects and when the specific command is active, you need to add the correct alias name to
the Aliases property.

4. In the Command List pane, locate the command(s) that you want to add to the new shortcut menu.
Select the command and hold down the left mouse button.  Drag and drop the command up to the
new pull-down menu under the Shortcut Menus node.  

5. Click Apply to save the new shortcut menu to the .CUI file.

NOTE:  More than one command can be selected at a time using the Ctrl and Shift keys when selecting
commands in the Command List pane.  This action allows you to quickly add a number of commands to a
user interface element, such as a toolbar or pull-down menu.

Editing a Shortcut Menu

Edit a shortcut menu using the steps below:

1. Use the CUI or Toolbar command to open.
2. In the Customizations in pane, click the plus sign next to the Shortcut Menus node in the tree view. 
3. Select the desired shortcut menu.  The Properties pane opens on the right of the Customize User

Interface window.
4. Make the necessary changes to the shortcut menu properties and its associated commands.
5. Click Apply to save the changes back to the .CUI file.

Adding a Separator or a Sub-menu

For more information on these two topics see “Adding a Separator” or “Adding a Sub-menu” under
“Working with Pull-down Menus.”

Organizing Commands, Separators, and Sub-menus on a Pull-down Menu

After they have been added to a shortcut menu, it is helpful to organize the commands, separators, and
sub-menus to make them easy to find and use.  The same process that is used to add commands to a
shortcut menu or sub-menu is used to organize the menu items on a shortcut menu.  Select the
command, separator or sub-menu and drag it up or down under the shortcut menu.  A drop location
indicator is displayed to indicate where the current item will be placed.  Unlike a toolbar, there is no way
to preview a shortcut menu until it has been saved and used in AutoCAD.
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WORKING WITH KEYBOARD SHORTCUTS
Keyboard shortcuts in AutoCAD are represented by two different kinds, shortcut keys and temporary
override keys.  Shortcut keys are used to execute a command, whereas temporary override keys are used
to toggle a setting on or off or to run two different macros based on the position of the key combination. 

There are many standard shortcut keys that you may use everyday.  Shortcut keys use a combination of
either the Ctrl key with or without the Shift and/or Alt key plus some other alpha-numeric key on the
keyboard.  For example, Ctrl+S executes the Qsave command.

Temporary override keys are new for AutoCAD 2006.  Temporary override keys use a combination of the
Shift key with some other alpha-numeric key on the keyboard.  Temporary override keys are used to
toggle an individual drafting setting, but can also run a macro when certain commands, like Line, are
active.  

Shortcuts Pane
A new pane in the dynamic
display pane (right side of the
Customize User Interface window)
titled Shortcuts is available for both
shortcut keys and temporary over-
ride keys (Fig. 45-24).  This pane
provides information about the
existing shortcut keys, such as
what key sequences are assigned.
You can use the Shortcuts pane to
access either one of the two types
of keys already set up.  You could
also copy the listing of keys to the
clipboard and paste them in a dif-
ferent application or make a hard-
copy of the keys using your
printer.

Properties of a Shortcut Key

Since a shortcut key is based on a command in the Command
List pane, it inherits the Name, Description, Macro, and Element
ID properties from the command.  Only one new property
called Key(s) is introduced and is explained below.

Key(s)
Key(s) is used to assign which key combination(s) execute the
command.  To specify a new key or to change an existing one,
select this field to display the ellipsis button.  Click the ellip-
sis button to display the Shortcut Keys dialog box (Fig. 45-25).
Click in the Press new shortcut key text field and press and
hold down the desired modifier keys (Ctrl and/or Alt) along
with the desired single alpha-numeric key to create the short-
cut key combination.  Click Assign to add the key combina-
tion to the shortcut key.  Then click OK to add the new key
combination.

FIGURE 45-24

FIGURE 45-25
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Creating a Shortcut Key

To create a new shortcut key follow the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, click the plus sign next to both the Keyboard Shortcuts and Shortcut Keys

nodes in the tree view.
3. In the Command List pane, locate the command(s) that you want to use to assign a shortcut key.  Select

the command with the left mouse button and holding down the left mouse button drag and drop the
command(s) up to the Shortcut Keys node.  

4. Make any desired changes to the Key(s) property of the new shortcut key.
5. Click Apply to save the new shortcut key to the .CUI file.

NOTE:  Remember that you can use the Ctrl and Shift keys when selecting commands in the Command
List pane to quickly add a number of commands to a user interface element, such as a toolbar or pull-
down menu.

Editing a Shortcut Key

Follow the steps below to edit a shortcut key:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, click the plus sign next to both the Keyboard Shortcuts and Shortcut Keys

nodes in the tree view.
3. Select the desired shortcut key that you want to change.  The Properties pane opens on the right.
4. Make the necessary changes to the shortcut key’s properties.
5. Click Apply to save the changes back to the .CUI file.

Properties of a Temporary Override Key

Unlike shortcut keys, temporary override keys are not based on existing commands from the Command
List pane.  Although shortcut keys and temporary override keys both have Name, Description and Key(s)
properties, a temporary override key also has a Macro1 (Key Down) and a Macro2 (Key Up) property to
toggle the drafting setting.  These macros are created in the same way that a macro is created for a
command.

Macro 1 (Key Down)
Macro 1 (Key Down) is used to define what command string is executed when the key combination is
pressed and held down while an AutoCAD command is running.  If no macro is added to the Macro 2
(Key Up) property, the same macro is used from the Macro 1 (Key Down) property.

Macro 2 (Key Up)
Macro 2 (Key Up) is used to define what command string is executed when the key combination is
released while an AutoCAD command is running.

Creating a Temporary Override Key

To create a new temporary override key follow the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, click the plus sign next to the Keyboard Shortcuts node in the tree view.
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3 Right-click on the Temporary Override Keys node and select New> Temporary Override from the short-
cut menu to open the Properties pane.

4. In the Properties pane, make the necessary changes to the Key(s), Macro 1 and Macro 2 property of the
new temporary override key.

5. Click Apply to save the new temporary override key to the .CUI file.

Editing a Temporary Override Key

To edit a temporary override key follow the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, click the plus sign next to the Keyboard Shortcuts node, then the

Temporary Override Keys node.
3. Select the temporary override key that you are interested in making changes to.  The Properties pane

opens in the Dynamic Display pane.
4. Make the necessary changes to the temporary override key’s properties.
5. Click Apply to save the changes back to the .CUI file.

WORKING WITH MOUSE BUTTONS
The Mouse Buttons section of the Customize User Interface window is used to specify the actions that occur
by clicking the mouse buttons.  The left mouse button (button 1) is always used to pick (select) a loca-
tion, menu item, or object in AutoCAD unless it is otherwise “remapped” using mouse software pro-
vided by the manufacturer.  In most cases, button 2 is the right mouse button and button 3 is the middle
mouse button.  The mouse buttons can be used as a simple click (press) operation alone or with a combi-
nation of the Ctrl and/or Shift key. 

Mouse buttons have only an Aliases property.  The Aliases start at AUX1 for the first combination (Click),
increments to AUX2 for the next combination (Shift+Click), and so on.  There are only four mouse button
combinations possible; however, it is possible to add more than one command (and button) to these
combinations.  You can add new buttons using basically the same procedure used to add commands to a
toolbar or pull-down menu.  If a new button or command is added to the combination, AutoCAD incre-
ments the button number by 1.

Adding a Button to a Mouse Button

Create a new button using the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, click the plus sign next to Mouse Buttons, then click the plus sign next

to the desired combination node (such as Shift+Click).
3. In the Command List pane, locate the command(s) that you want to add to the mouse button.  Select

the command with the left mouse button, and holding down the left mouse button drag and drop
the command up to the desired mouse button node.

4. Click Apply to save the new shortcut menu to the .CUI file.

NOTE:  You can use the Ctrl and Shift keys to select multiple commands in the Command List pane.  
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Editing a Button to a Mouse Button

To edit a button follow these steps:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. In the Customizations in pane, click the plus sign next to Mouse Buttons, then click the plus sign next

to the desired combination node (such as Shift+Click).
3. Select the button that you want to edit.
4. Make the necessary changes to the button’s properties.
5. Click Apply to save the changes back to the .CUI file.

Pointing Devices and the MBUTTONPAN and ZOOMFACTOR System Variables

You can specify points in the AutoCAD drawing area and select commands using a pointing device such
as a standard mouse, an IntelliMouse®, or a digitizing tablet.  Some pointing devices, such as a mouse,
may have only two buttons, while others, such as a digitizing puck, may have many buttons.  AutoCAD
assigns the actions of the first 10 buttons automatically, but you can reassign the action of the buttons
(except the pick, or first, button) by modifying the Mouse Buttons in the Customize User Interface window.
The following sections explain the actions of the buttons, assuming that the ACAD.CUI file contains the
default settings supplied with AutoCAD.

Two-Button Mouse
On a two-button mouse, the left button is the “pick” (or select) button used to specify points on the
screen, or select menu options, or select objects.  The right button can either produce a shortcut menu or
act as an Enter, depending on your pointer location and the right-click settings you specify in the Options
dialog box or SHORTCUTMENU system variable (see “Controlling Default-mode, Edit-mode, and
Command-mode Shortcut Menus”).  Also with a two-button mouse, holding down the Shift key while
right-clicking displays the Object Snap shortcut menu.

Three-Button Mouse and MBUTTONPAN

With a three-button mouse, holding down the middle button and dragging the mouse accomplishes a
real-time Pan by default.  However, the middle button can either activate real-time panning or display
the Object Snap shortcut menu.  You can control which action the middle button has using the MBUT-
TONPAN system variable.  Possible settings for MBUTTONPAN are as follows: 

0 Supports the action defined in the AutoCAD customization (.CUI) file
1 Supports panning by holding and dragging the button or wheel

Since the middle button carries out the action as defined in the Customize User Interface window when
MBUTTONPAN is set to 0, you can use this button to produce the Object Snap shortcut menu by default,
or you can customize the button in the Customize User Interface window to define some other action for
the button.  System pointing devices such as a mouse use the sections defined under the Mouse Buttons
node in the Customize User Interface window to define the button actions.

IntelliMouse, MBUTTONPAN and ZOOMFACTOR

The IntelliMouse is a two-button mouse with a small wheel between the buttons.  The left and right
buttons have the same functions as a standard two-button mouse.  The wheel, however, can be rotated to
real-time Zoom in your drawing and can be held down to real-time Pan in the drawing without using
any commands.
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The wheel is designed to rotate in small increments rather than rotating smoothly.  Each increment in the
wheel rotation changes the Zoom by some regular amount (about 60% by default).  The ZOOMFACTOR
system variable controls the amount of this incremental change.  However, the amount of change is
inversely proportional to the value.  In other words, the higher the number, the smaller the change.  On
the IntelliMouse, you can press and hold down the wheel as well as rotate it.  If you press and hold
down the wheel, it has the same action as the middle button on a three-button mouse; that is, it performs
a real-time Pan.  As with a three-button mouse, you can change the MBUTTONPAN system variable
setting to 0 to cause the wheel button to display the Object Snap shortcut menu instead when it is
clicked.  Also, you can customize the .CUI file to define another action for the wheel button when
MBUTTONPAN is set to 0 (see “Three-Button Mouse and MBUTTONPAN”).

WORKING WITH LISP FILES
The LISP Files section of the Customize User Interface is used to specify what AutoLISP files are to be
loaded with the .CUI file.  This is a more organized approach than using the Startup Suite under the
Load/Unload Applications dialog box of the Appload command.  For a group of computers, if you don’t
want to manually go around to each machine and add the AutoLISP file to the Startup Suite and don’t
know any AutoLISP programming code, this method is much easier to use.  The disadvantage to this
method is that it only supports files with the extension .LSP but not .FAS or .VLX.  If you want to load
these and other external program files, like ObjectARX programs, it is best to learn some AutoLISP pro-
gramming and add the load statements to the ACAD.MNL file or ACADDOC.LSP.  In this case, a few
AutoLISP load statements are given below to get you started.

Use the statement below to load a .LSP, .FAS or .VLX file into AutoCAD through the .MNL file.

Syntax: (load “filename”)
Example: (load “my_utils.lsp”)

The example loads a file called my_utils.lsp which must be present in the AutoCAD support directories.

Use the statement below to load an ObjectARX (.ARX) file into AutoCAD through the .MNL file.

Syntax: (arxload “filename”)
Example: (arxload “my_utils”)

The example loads a file called my_utils.arx which must be present in the AutoCAD support directories.
The file extension is not required since the arxload function only loads files with an .ARX file extension.

WORKING WITH LEGACY MENU ELEMENTS 
The Legacy node contains some of the older user interface elements that have been around for some time
and are slowly being phased out.  Under this section Tablet Menus, Tablet Buttons, Screen Menus and Image
Tile Menus can be located.  Tablets, or digitizers as they are more commonly known, are a form of
inputting coordinates and executing commands.  Screen Menus once were one of the main ways to
execute commands in early versions of AutoCAD.  The replacement of screen menus started in Release
10 with the introduction of pull-down menus and in Release 13 with the introduction of toolbars.  The
screen menu window is still available in AutoCAD 2006, but is turned off by default.
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Much like the screen menu, Image Tile Menus are being phased out.  Once a very powerful and visual
user interface element, these menus have been replaced for the most part by a much improved interface
called Tool Palettes.  Image tile menus can still be useful in managing existing block libraries with some
of the customization that is out there.  To learn more about the Legacy interface elements, select the
Legacy node in the Customizations in pane.  Once the Legacy node is selected, click the Learn more about
legacy interface elements link in the Information pane.

WORKING WITH PARTIAL .CUI FILES 
The concept of using partial customization files has been around for a long time in AutoCAD and is still
supported with AutoCAD 2006.  AutoCAD 2006, however, makes the implementation of partial cus-
tomization files much easier than in previous releases.

A partial customization file normally contains a special set of custom commands and user interface ele-
ments.  It is called a partial customization file because it acts as an “overlay” to the ACAD.CUI file itself.
Therefore, the ACAD.CUI file (standard commands and elements) is loaded by default, and you can
overlay a custom .CUI file (with special commands and elements) to your user interface.  Typically a
partial customization file contains a small set of commands and user interface elements specific to
company standards or a set of personal tools that is added “on top of” the standard set of elements in the
ACAD.CUI file.  The main advantage of using this feature is that the customized elements are self-con-
tained, making it simple to create, maintain, and overlay these to the standard elements, as well as
making migration to future AutoCAD releases easier.  There is no limit to the number of partial cus-
tomization files that can be used, and unlike previous releases, references to partial .CUIs that are loaded
are maintained in the main ACAD.CUI file.  This action ensures that specific partial customization files
are loaded with the main customization file each time it is loaded, without having to write AutoLISP
code to control the files.

NOTE:  An inconvenience in the Customize User Interface window is that you cannot directly create new
commands and elements in a new partial customization file.  You must first create an “empty” partial
customization (.CUI) file (that is, one containing no special commands or user interface elements), and
second, load the new file and create the new commands and user interface elements such as toolbars and
menus.  

1. To Create an “Empty” Partial Customization (.CUI) File

Follow these steps to create a new partial .CUI file containing no commands or elements:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. Select the Transfer tab at the top of the Customize User Interface window.  (Before this point you have

been doing everything in the Customize tab.)
3. In the Customizations in pane on the right side of the Customize User Interface window, select New CUI

File from the drop-down list.  If you double-click each node in the new .CUI file you can see that
there are no commands or elements associated with any node.

4. Select Save As from the same drop-down list
5. In the Save As dialog box, enter a name for the partial customization file in the File name text field.
6. Click Save to create the .CUI file on disk.  
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2. To Create New Commands and Elements in a New Partial .CUI File

Once the new partial customization file has been created, follow these steps to create new commands
and user interface elements.

1. Type in MENUNAME at the command line.  Take note of the current customization file.  By default
the ACAD.CUI file is the loaded customization file which is located at C:\Documents and
Settings\<user name>\Application Data\Autodesk\AutoCAD 2006\R16.2\enu\support.

2. Enter the Menu command at the Command line to open the Select Customization File dialog box.
Select the newly created menu (.CUI) file.

3. Browse to the location where you saved your new partial customization file.  Select the new .CUI file
and click Open.  This action ensures that the partial customization file is set as the main file.

4. Use the CUI or Toolbar command to open the Customize User Interface window.
5. Select the Customize tab at the top of the Customize User Interface window.
6. In the Command List pane, select the New button.  Create new commands from scratch by entering the

desired Name and Macro in the Properties pane.  If needed, create new button images for the com-
mands using the Button Image pane.  Press Apply to add new commands to the Command List.

7. In the Customizations in Main CUI pane, create any user interface elements such as pull-down menus
and toolbars.  Drag and drop the new commands from the Command List up to the new toolbars and
menus.

8. In the Customization in pane, select Open from the drop-down list and reload the previous customiza-
tion file that you took note of back in step 1 as the main .CUI file.  

9. Load your newly edited .CUI file by right-clicking on the Partial CUI node and selecting Load partial
customization file.  

10. Click OK when the Warning dialog box is displayed informing you that any workspaces in the partial
customization files are not available for use.  Once the partial customization file is loaded, be sure to
update any workspaces with any of the user interface elements located in the partial customization
file that you want displayed (see “Using Workspaces to Organize the User Interface”).

The previous procedure assumes a typical application—that commands are created “from scratch” by
entering the needed command names, special characters, AutoLISP routines, or other information into
the Macro field of the Properties pane.  However, you may want to load standard AutoCAD commands
into your custom .CUI file, then alter those commands.  To load standard AutoCAD commands into a
partial customization file, follow the steps below:

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. Switch to the Transfer tab in the Customize User Interface window.  In the Customization in pane on the

left side, ensure the Main CUI File (acad.cui) is listed.  If not, select it from the drop-down list.  In the
Customization in pane on the right, use the drop-down list to select your new partial customization
file (you may have to select Open from the list).  If the Warning dialog box is displayed, click OK.
NOTE:  This process varies slightly based on whether your partial .CUI file is already loaded or not.

3. Drag and drop the desired elements and commands from the ACAD.CUI to the partial customiza-
tion CUI.  Create new toolbars and menus as needed in the partial customization file.

4. Select OK to save the changes.
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WORKING WITH ENTERPRISE .CUI FILES 
Enterprise customization files are new in AutoCAD 2006.  An enterprise customization file, or company
customization file, is designed primarily for a CAD manager to control company standards and tools,
whereas a partial customization file is designed for personal preferences.  One of the advantages of the
enterprise customization file for CAD managers is that it cannot be customized through the Customize
User Interface window because it is displayed there as read-only.  Unlike partial customization files,
enterprise customization files are capable of controlling workspaces to help enforce company standards.
An enterprise customization file can be thought of as a replacement for the main customization file,
although it is possible to use both the main and enterprise customization files.  An enterprise customiza-
tion file is loaded prior to the main customization file.  

The following steps explain how to load an enterprise customization file in AutoCAD 2006.

1. Use the Options command to open the Options dialog box.
2. Select the Files tab and double-click Customization Files.
3. Double-click Enterprise Customization File.  The default value is ‘ . ‘.
4. Click Browse and select the customization file that you want to load as the enterprise customization

file in the Select a file dialog box.  Click Open after selecting the customization file.
5. Click OK to accept the change to the Enterprise Customization File option.
6. Use the CUI or Toolbar command to open the Customize User Interface window to verify the enterprise

customization file cannot be changed.

NOTE:  Be sure not to set the same customization file for both the Main Customization File and Enterprise
Customization File under the Files tab of the Options dialog box.  You usually use one or the other cus-
tomization file in most cases.

MIGRATING CUSTOMIZATION FILES FROM A PREVIOUS RELEASE
The Customization User Interface window is not only a very powerful editor for creating and editing user
interface elements, but it can be used to migrate older customized menu files to the new release of
AutoCAD.  You can open either of the legacy menu formats from a previous release (.MNU or .MNS)
using the Transfer tab of the Customization User Interface window.  Here a .MNU or .MNS menu file is
automatically converted to the new .CUI file format when saved, but the selected .MNU or .MNS file is
not changed or removed from the disk.

Although it is possible to migrate an entire older customized menu (.MNU or .MNS) file to a new cus-
tomization (.CUI) file, the resulting new .CUI file would not contain any of the new commands that are
in the new release of AutoCAD.  Therefore, two methods of migration are most useful.  First, you can
open an older .MNU or .MNS file and drag and drop individual user interface elements (such as a
toolbar item, menu item, or entire pull-down menu or toolbar) into an existing main .CUI file.  Second,
you can use a similar method to create a new customization (.CUI) file that can be loaded as a partial
customization file.  
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The following steps explain how to load a .MNU or .MNS file from a previous release and drag and drop
selected user elements to a main .CUI file.  

1. Use the CUI or Toolbar command to open the Customize User Interface window.
2. Select the Transfer tab at the top of the Customize User Interface window.
3. In the Customizations in pane on the right side of the Customize User Interface window, select New CUI

File from the drop-down list.  (You can actually use either side of the Transfer tab since items can be
copied to or from either side.)  

4. In the Open dialog box that appears, browse to the location of the desired .MNU or .MNS file from a
previous release.  By default the Open dialog box displays only customization (.CUI) files; therefore,
to view legacy menu files, select Menu files from the Files of type drop-down list.  (The .MNU and
.MNS files for AutoCAD 2004 or 2005 are located in the directory C:\Documents and Settings\<user
name>\Application Data\Autodesk\AutoCAD 200x\R16.x\enu\support by default.  If you are upgrad-
ing from AutoCAD 2000 to 2002, the .MNU or .MNS files are located in the directory C:\Program
Files\AutoCAD 200x\Support.)

5. Select the desired file and click Open.  AutoCAD creates a new .CUI file from the contents of the
menu file.

6. Expand the desired user interface element node under the new .CUI file.  Do the same for the .CUI
file located in the Customizations in pane located on the left side of the Customize User Interface
window.

7. Drag customization items from the right to the left side of the Customize User Interface window.
8. Click OK to save the changes.

It is also possible to use the Transfer tab to create a new customization file that can be loaded as a partial
customization file.  To export older customization elements to a new customization file, first create a new
.CUI file using the Transfer tab, then copy the older elements to the new file in a manner similar to that
described above.  Once the desired customization has been copied, use the Save As option to save the
.CUI file to disk.

NOTE:  If your existing menus use custom images for any of the toolbar buttons, make sure the button
image files are copied into a directory that is part of the AutoCAD 2006 support paths.  If not, the images
appear as a question mark.

NOTE:  If you have custom screen menus and/or image tile menus, you must also migrate those
through the Customize User Interface window.  These menus, as well as tablet menus and buttons, are
located under the Legacy node in the Customizations in pane.  

USING WORKSPACES TO ORGANIZE THE USER INTERFACE
A workspace is a new feature in AutoCAD 2006 that provides a method for organizing and saving user
interface element configurations.  The user interface elements that are controllable through a workspace
are toolbars, pull-down menus, dockable windows (such as the Properties palette, Tool Palette,
DesignCenter, etc.), and a few other application settings.  Therefore, use workspaces to configure and
save specific user environments in AutoCAD.  There are a two ways to create and manage workspaces:
the Customize User Interface window and the Workspace toolbar.
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Working with Workspaces in Customize User Interface Window

The Customize User Interface window pro-
vides the greatest control over the way
workspaces can be created and managed.
Workspaces are saved within the .CUI file
and can be shared with others who use the
same .CUI file.  Workspaces utilize a
Workspace Contents pane (Fig. 45-26) for
making changes to the visibility of toolbars,
pull-down menus, and dockable windows,
and control the order in which pull-down
menus appear along the menu bar (at the
top of AutoCAD window).

Properties of a Workspace

To view the properties of the default workspace, open the Customize User Interface window, examine the
Customizations in pane, and expand the Workspaces node (at the top of the hierarchy) by selecting the +
(plus) sign.  Next select the AutoCAD Default workspace.  This action opens the Workspace Contents pane
(see Fig. 45-26) and the Properties pane on the right.  The following properties are displayed for a
workspace.

Name
Each workspace must have a unique Name.  Each workspace is listed or referenced by its Name in the
Customize User Interface window, the Workspaces toolbar, the Workspaces option under the Window pull-
down menu and the Wsettings command.

Description
Description is not displayed in the status bar area, but this field can be used to save additional text infor-
mation for the workspace if needed.

Start On
The Start On property determines which type of layout, if any, should be set current when the workspace
is applied.  The three options are:  Model (sets the Model tab current), Layout (sets the last active layout
current), and Do not change (keeps the current layout).

Model/Layout tabs
This option determines the display of the Model and layout tabs at the bottom of each drawing window
when the workspace is applied.  The three options are:  On (displays the Model and layout tabs), Off
(hides the Model and layout tabs), and Do not change (keeps the current Model and layout tabs settings).

Screen menus
This option controls the display of the screen menu when the workspace is applied.  This setting is
important only if you use the legacy screen menus.  The three options are:  On (displays the screen menu
window), Off (hides the screen menu window) and Do not change (keeps the current setting). 

FIGURE 45-26
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Scroll bars
The Scroll bars property is used to control the display of the scroll bars when the workspace is applied.
Similar to the previous properties, the options are On, Off, and Do not change. 

Creating a Workspace with the Customize User Interface Window

The following steps explain how to create a new workspace to specify the existence and location of tool-
bars, pull-down menus and dockable windows. 

1. Use the CUI or Toolbar
command to open the
Customize User Interface
window and select the
Customize tab at the top of
the Customize User Interface
window.

2. In the Customizations in
pane, select the Workspaces
node in the tree view.

3. Right-click on the
Workspaces node and select
New> Workspace from the
shortcut menu.  The
Workspace Contents and
Properties panes are opened
on the right side of the
Customize User Interface window.

4. Make the necessary changes to the new workspace Properties.  You must at least change the Name.
5. Click the Customize Workspace button at the top of the Workspace Contents pane.
6. In the Customizations in pane, expand the Toolbars and/or Menus node under any of the loaded .CUI

files (including loaded partial customization files).  Figure 45-27 shows the Menus node expanded
under the Customizations in pane.

7. Select the user interface elements that you want displayed in the new workspace.  A check in the
checkbox indicates the item next to the box is included in the new workspace, while no check clears
the item from being included.  You can select individual toolbars and pull-down menus, or you can
select the entire set of toolbars and/or menus.

8. Once the desired menus and toolbars have been included in the new workspace, use the Workspace
Contents pane to change the order of the toolbar and menu items, if desired, using drag-and-drop.
(Top down order in the Customize User Interface window equates to left to right on the menu bar.)

9. Specify the orientation of individual toolbars by selecting each in the Workspace Contents pane, then
changing the Orientation, Default X Location, and Default Y Location in the Properties pane below.

10. Specify the appearance and size of the dockable windows by selecting each in the Workspace Contents
pane, then changing the specific properties in the pane below.

11. Click Done at the top of the Workspace Contents pane to save and exit the customize workspace
process.

12. To set the workspace current, right-click the workspace under the Workspaces node of the tree view in
the Customizations in pane, then select Set Current from the shortcut menu.

13. Click OK to save the changes back to the .CUI file and apply the workspace.

FIGURE 45-27
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Editing a Workspace

1. Use the CUI or Toolbar command to open the Customize User Interface window and select the
Customize tab at the top of the Customize User Interface window.

2. In the Customizations in pane, click the plus sign next to the Workspaces node in the tree view.
3. Select the desired workspace and click Customize Workspace under the Workspace Contents pane.
4. Make any necessary changes, then select Done in the Workspace Contents pane.
5. Click OK to save the changes to the .CUI file.

The Workspaces Toolbar

The Workspaces toolbar (Fig. 45-28) allows you to
perform a variety of tasks with workspaces.  For
example, this feature provides a fast way to specify
the display and position of toolbars and dockable
windows for the current workspace outside of the
Customize User Interface window.  Although these
tasks are made easy, it is not possible to completely
customize a workspace using the Workspaces
toolbar.  The order and display of pull-down
menus must be specified using the Customize User
Interface window.  

Functions of the Workspaces toolbar are given below.

1. Make a workspace current:  Select an existing workspace from the drop-down list.
2. Create a new workspace:  (See “Creating a Workspace with the Workspaces Toolbar.”)
3. Produce the Customize User Interface window:  Select Customize from the drop-down list.
4. Produce the Workspace Settings dialog box:  Select the Workspace Settings button (see “Workspace

Settings and WSCURRENT” for more information). 
5. Make My Workspace current:  Select the My Workspace button (see “Workspace Settings and WSCUR-

RENT” for more information). 

Creating a Workspace with the Workspaces Toolbar

The following steps explain how to create a new workspace using the Workspaces toolbar. 

1. Right-click on a toolbar and select Workspaces to display the Workspaces toolbar.
2. Make the desired changes to the layout of toolbars and dockable windows in your current session of

AutoCAD.
3. Select Save Current As from the drop-down list on the Workspaces toolbar to produce the Save

Workspace dialog box (not shown).
4. Enter a name for the new workspace in the Name field and click Save.

FIGURE 45-28
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Workspace Settings and WSCURRENT

The Workspace Settings dialog box (Fig. 45-29) allows you
to control how changes to a workspace are saved and
what options appear in the Workspaces toolbar and
Workspaces menu option under the Window pull-down
menu.  The Workspace Settings dialog box provides the
following options.

My Workspace drop-down list 
This list allows you to specify which workspace is used
when the My Workspace button is clicked.  The My
Workspace button appears in the Workspaces toolbar (see
Fig. 45-28).  This feature allows you to quickly reset the
user interface elements in the current session with any
existing workspace you designate as My Workspace.

Menu Display and Order
The middle section is used to adjust the order in which
the workspaces are arranged in the drop-down list on
the Workspaces toolbar and under the Workspaces option
under the Window pull-down menu.  You can select
which workspaces are displayed and use separator bars
to group workspaces.

When Switching Workspaces
The bottom section of the Workspace Settings dialog box specifies if changes to workspaces are automati-
cally saved or not.  For example, if Automatically save workspace settings is checked, the current workspace
(the current display and position properties of the toolbars and dockable windows) is automatically
saved when you switch to a different workspace.

The Workspaces option in the Windows pull-down menu
The Window pull-down menu (Fig. 45-30)
contains the same functionality that can
be found on the Workspaces toolbar.
However, there is one exception—the My
Workspaces option is not available.

WSCURRENT
The WSCURRENT system variable stores
the name of the current workspace and can
be used to set a workspace current.  

Command: wscurrent
Enter new value for WSCURRENT
<”AutoCAD Default”>: (Enter an exist-
ing workspace name)
Command:

One use of the system variable might be to
ensure that the expected workspace is set
current during the loading of the
ACAD.LSP file that is automatically loaded
at startup.

FIGURE 45-29

FIGURE 45-30
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TIPS AND TRICKS
Below are some tips and tricks that help to improve productivity with the Customize User Interface
window and extend the capabilities of the shortcut keys that are part of the Customize User Interface
window.

Resizing Panes in the Customize User Interface window

It is possible to resize the indi-
vidual panes of the Customize
User Interface window.  This
feature allows you to see some of
the items that might normally be
hidden or that you would have to
scroll to see.  To resize the panes in
the Customize User Interface
window, position the cursor in
between two panes vertically or
horizontally.  The cursor changes
to a divider with arrows pointing
in opposite directions so the pane
can be adjusted (Fig. 45-31).  Hold
the left mouse button down and
drag in the direction you want the
pane to stretch.  

Adding Command Tools to a Tool Palette Based on Commands Created in the
Customize User Interface Window

One of the enhancements to tool palettes added in AutoCAD 2005 was the ability to add a command to a
tool palette, including a newly created “custom” command created in the Customize dialog box.
Although this task is still possible, the process has become more involved in AutoCAD 2006.  The follow-
ing steps explain how to add a command that is created in the Customize User Interface window to a tool
palette.

1. Use the CUI or Toolbar command to open the Customize User Interface window and select the
Customize tab at the top of the Customize User Interface window.

2. If not already existing, create the desired new commands.
3. Create a new toolbar and add the commands to it (commands that you eventually want to place on

the tool palette).
4. Click OK to save the changes back to the .CUI file.
5. If the new toolbar is not visible on the screen, display the new toolbar by right-clicking on a toolbar

that is currently displayed and selecting the new toolbar name from the shortcut menu.
6. Ensure the desired tool palette (that you want to add the commands to) is also displayed on the

screen.
7. Use the Customize command to open the Customize dialog box.  
8. With the Customize dialog box displayed, drag the new commands from the toolbar to the tool

palette.  This will cause a new command tool to be added to the tool palette.
9. Click Close to save changes to the tool palette and to exit the Customize dialog box.

FIGURE 45-31
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Using Virtual Keys with Shortcut Keys

In previous releases of AutoCAD, it was possible to create shortcut keys using virtual keys.  Virtual keys
are keys on the keyboard that have specific names like F1 or NUMPAD0.  Virtual keys are not supported
in the Customize User Interface window.   However, it is still possible to create shortcut keys that use
virtual keys in AutoCAD 2006 using a .MNU or .MNS file format to import the keys.

The virtual keys that you can create using this method are listed in the table below.  The keys must also
have double quote marks on both sides of the name as shown in step 4 below for the key assignments.

String Description Exceptions
F1 F1 key Although the F1 key can be assigned a menu macro, this

change is discouraged because this key is generally associ-
ated with Help.  Using a modifier with this key is acceptable.

F2 F2 key Unmodified, this toggle key switches the state of the text
window.

F3 F3 key Unmodified, this toggle key switches OSNAP on or off.
F4 F4 key Unmodified, this toggle key switches TABMODE on or off.
F5 F5 key Unmodified, this toggle key switches ISOPLANE on or off.
F6 F6 key Unmodified, this toggle key switches COORDS on or off.
F7 F7 key Unmodified, this toggle key switches GRIDMODE on or off.
F8 F8 key Unmodified, this toggle key switches ORTHOMODE on or

off.
F9 F9 key Unmodified, this toggle key switches SNAPMODE on or off.
F10 F10 key Unmodified, this toggle key switches Polar Tracking on or

off.
F11 F11 key Unmodified, this toggle key switches Object Snap Tracking

on or off.
F12 F12 key Unmodified, this toggle key switches DYNMODE on or off.
INSERT Ins key None
DELETE Del key None
ESCAPE Esc key Although the Esc key can be assigned a menu macro, it is

discouraged because this key is generally associated with
Cancel.  Ctrl+Esc and Ctrl+Shift+Esc cannot be assigned a
menu macro; these sequences are controlled by Windows.

UP up arrow key Must be used with the CONTROL modifier.
DOWN down arrow key Must be used with the CONTROL modifier.
LEFT left arrow key Must be used with the CONTROL modifier.
RIGHT right arrow key Must be used with the CONTROL modifier.
NUMPAD0 0 key None
NUMPAD1 1 key None
NUMPAD2 2 key None
NUMPAD3 3 key None
NUMPAD4 4 key None
NUMPAD5 5 key None
NUMPAD6 6 key None
NUMPAD7 7 key None
NUMPAD8 8 key None
NUMPAD9 9 key None
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To create shortcut keys using virtual keys, follow the steps below:

1. Start Notepad by going to the Start button in the Windows taskbar.  The select Programs > Accessories
> Notepad.

2. In Notepad, select File > Save As.
3. In the Save As dialog box, select All Files from the Save as type drop-down list.
4. Enter a name ending with .MNS in the File Name field, like ExtendKeys.mns and click Save.  Make

sure to remember where the file is being created on disk.
5. In Notepad, type the following:

***MENUGROUP=SKEYS

***ACCELERATORS

The value after the equals symbol on the line beginning with **MENUGROUP can be any name that
you want as long as it uses all alpha characters and contains no spaces.  The value is just to get the
file imported into the Customize User Interface window and nothing more.  ***ACCELERATORS is
used to notify the import process that the interface elements to follow are of the shortcut key type.

6. Once the header information is in the file, the actual key definitions need to be added.  To do that,
follow the syntax and examples below.

Syntax: [Modifier(s)+accelerator_key] command string

Examples:

[CONTROL+”INSERT”]._-INSERT
[INTERNAL+”F1”]^c
[“NUMPAD9”]45

The first example uses the Ctrl modifier with the Ins key to start the Insert command.  The Shift mod-
ifier can be used with the Ctrl modifier, like [CONTROL+SHIFT+”INSERT”]._-INSERT.  The second
one uses a special modifier called INTERNAL which overrides the Function keys.  The third and final
example shows how to map an angle value to the Number Pad section of the keyboard.

7. In Notepad, select File > Save.
8. Use the CUI or Toolbar command to open the Customize User Interface window and select the Transfer

tab at the top of the Customize User Interface window.
9. In the Customizations in pane on the right side of the Customize User Interface window, select Open

from the drop-down list.  In the Open dialog box, browse to the .MNS file that you created.  Make
sure Menu files is selected from the Files of type drop-down list.

10. Select the menu file and click Open.
11. Expand 4both the Keyboard Shortcuts and Shortcut Keys nodes in the two Customization in panes.
12. Select the shortcut keys from the menu file that was just imported and drag them over to the .CUI file

that is on the left side of the Customize User Interface window.  Once copying the commands is com-
plete, click OK and test the new shortcut keys.

You can make changes to the macros as needed once they have been placed into the .CUI file, but you
won’t be able to reassign the virtual key in the Customize User Interface window if it gets removed acci-
dentally.  In this case, you must repeat the import process.


